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The SEQUENCE VIEWER program 
 
 
SEQUENCE VIEWER is a program for observing and analysing sequential data. For example, life events, husband-
wife interactions, newspaper messages about ongoing topics, or interviewer-respondent interactions; we will 
use this latter kind of interaction as an example for the discussion of SEQUENCE VIEWER. 

SEQUENCE VIEWER provides you with extensive online help. On most windows a help button is available, that 
brings you to a page in the help file. Moreover, most windows have an option that if you move the mouse over 
buttons and fields, you get a short explanation about its function.  

Part 1 of this reference treats the data structure of SEQUENCE VIEWER files. In part 2 the main sequence 
window, its drawers and the toolbar are described. In part 3 the different menu items are shortly discussed. In 
part 4 a number of buttons that are common to many windows are explained in more detail. Part 5 consists of a 
glossary, describing a number of common terms.  
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1. Data structure 
 
A sequence file consists of a number of sequences. A sequence consists of a number of descriptions of states 
or events. For example, in studying job careers, the job career of each person represents a sequence of different 
successive jobs (events), whereas different persons represent different sequences. Or in studying interviewer-
respondent interactions, each question from a questionnaire, posed to a respondent, may indicate the start of a 
new sequence, consisting of all verbal acts of interviewer and respondents, related to that very question.  
 
1.1. Events 
 
Such job descriptions, or verbal acts in a survey-interview, are called events. It should be noted here that the term 
‘event’ is not always appropriate, depending on the kind of data to be analysed. For example, in analysing job 
careers, the description of a job represents a state, whereas getting another job (a state transition) might be 
called an event. In the program however, only the term event is used. 

Each event can be described with up to nine code variables. The values of these code variables are 
alphanumerical codes and are called codes for short. Allowed codes are the characters ‘a’ to ‘z’, ‘A’ to ‘Z’, ‘0’ to 
‘9’ and ‘-‘ (the dash is the general code for ‘not coded yet’). Thus, a code variable may have a range of maximally 
63 different values. An example of a very simple sequence might be: 
 
IQ RA IR 
 
The Interviewer poses a Question; 
the Respondent gives an Answer; 
the Interviewer indicates that the answer is Received; e.g. “Thank you”. 

 
This sequence consists of three events; each event is described with two event variables (the actor and the kind 
of verbal act). The full code for an event (like ‘IQ’) is called event code. 

In addition to the maximum of nine code variables, each event may be supplied with an unlimited number of 
event variables, describing other characteristics of an event; for example the offset time in seconds of a verbal 
act. Such a sequence might be coded as follows: 
 

IQ/4 RA/6 IR/8 
The question ends after 4 seconds, the answer after 6, and the reaction after 8 seconds. If the sequence starts 
at time 0 (zero), the program can calculate the duration of each event (e.g. the answer takes 2 seconds) and 
store such information as another event variable. 
 
Finally, each event can be supplied with text information. In the example above, the verbal acts themselves (the 
question posed by the interviewer, the answer given by the respondent). 
 

 
The screenshot above shows the main screen, including two drawers. In this example, the events are described 
with three code variables; the first one describes the speaker, the second one the type of utterance, and the third 
one the adequacy of the utterance, e.g. an ‘A’ if the question is posed as scripted. Of course the user can define 
his or her own coding scheme. 
 
1.2. Sequences 
 
 As pointed out before, sequences are made up of events. Each sequence may contain an unlimited number of 
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events. 
Sequence variables describe characteristics of the whole sequence. Names and values of sequence 

variables appear in the drawer, to the left of the main window. The very first sequence variable, will always be 
SEQSIZE: the number of events in a sequence. You may add as many sequence variables to a sequence file as 
you wish; for example the gender of interviewer and respondent; the questionnaire number of the question, or 
the eventual score on the question posed. 

The drawer at the bottom of the screenshot above shows information that belongs to the whole sequence. 
Five tabs are available to enter any kind of text. In the screenshot above, the first tab shows the scripted question 
and answer alternatives. 

Further, to each sequence a reference to a sound or video file can be added. This linked file can be played 
directly from within SEQUENCE VIEWER. The program for example allows you to click on a particular utterance (e.g. 
“R: I’m satisfied, just satisfied”) to play exactly that particular part of the sound of video file. 

 
 

1.3. Coding 
 
If you analyse verbal interactions, you usually start with transcribing the utterances, using the sound (or video) 
file. Next you start coding (after you have defined your coding scheme): assigning codes to each event (e.g. 
utterances). The program has a number of options to ease the often tedious task of transcribing and coding. 
 
 
1.4. Keys 
 
In addition to coding, you can also assign keywords to pieces of text, or to pieces of an audio or video file. 
Assigning keys is more flexible than coding. For example, in case of text keys, you can assign a keyword to any 
part of the text you wish, e.g. starting at “are you with...” of the first event in the screen shot on the previous page, 
and ending with “...rather dissatisfied” in the second event. Keys can be useful for more qualitative analyses. 
They are also particularly useful to develop a coding scheme. You may start with assigning keywords to your text, 
on the basis of whatever strikes you. Next you can automatically assign codes to events, on the basis of which 
keywords covers part of an event text. 
 
 
1.4. Word links 
 
You can add a word link between any two words in the text. Word links are shown as an arrow between both 
words. You can give a colour, a name and an description to such a word link. 
 
 
1.5. Analyses and data manipulations 
 
The analyses performed by SEQUENCE VIEWER can be characterized by compacting the often enormous amount 
of coded sequential data, to find meaningful relations between events within a sequence, and between 
sequences within a file. All analyses can be performed on a subset of sequences, by selecting a range of values 
on a sequence variable. In addition SEQUENCE VIEWER has a large number of options for data manipulation. 
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2. Main parts 
 
2.1. The main sequence window 
 

 
 

 The lock sequence icon shows whether a sequence is locked. If a sequence is locked, values of sequence, 
event and code variables, cannot be changed. 

 The mark checkbox shows whether a sequence is marked or not. To mark a sequence manually, click on 
the mark checkbox. To unmark it, uncheck it. 

 You can choose between eight different mark sets; just select a set from the mark set popup menu. You 
can give each set a different name with File settings... from the File menu (select the Mark sets tab). Names 
of mark sets are saved with the file. 

 Click the add sequence button to insert a new sequence after the present sequence. To add a sequence 
before the present sequence, hold the option key down when you click the 'add sequence' button. To add a 
number of sequences at once, select Add sequences... from the Sequences menu. 

 Click the delete sequence button to delete the present sequence (you will get an alert before the sequence is 
actually deleted). To delete a number of sequences at once, select Delete sequences... from the 
Sequences menu. 

 The link button. Click it to link or unlink the event texts and the event codes of a sequence. If event texts and 
codes are linked, you cannot edit the event texts. 

 Check to show a sticky with annotations of word links and keys, when you move the mouse over words 
belonging to a key (see numbers 35, 36 and 37), or the arrow of a word link (see numbers 32, 33 and 34). 

 The show sequence definition button lets you show the effect of a sequence definition. With a sequence 
definition you can (temporarily) delete particular events, join similar successive events, and much more. The 
effect of a sequence definition is only shown in the codes and the codes and event variables mode of a 
sequence (see numbers 24, 25 and 26). 

 If the assign even time button is checked, the present onset or offset time of an audio or video file is assigned 
to the event when you click at the event code. This feature enables you to quickly assign onset and offset time 
to events. 

 Use the time switch button to quickly switch between onset and offset time, without using the event variable 
popup menu (see number 27). 

 The check field. To check (or uncheck) a particular event, click in this field, just before the event code. A 
checked event code has a check mark (√) in front of it (see also number 23). 

 The code field. Before the slash the codes appear, after the slash the event variable that is selected with the 
event variable popup menu (see number 27). 

 Example of a word link, connecting two words. Double click the arrow to enable you to delete a word link, and 
to change properties like the color, or to add annotations. 

 The words that are assigned to a particular key can be coloured (see numbers 32 and 33). 
 The sequence text field with the event texts. Event texts belonging to different events are separated by a 

carriage return. 
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 Click to go to the previous marked sequence (see number 2 and 3). If there are no marked sequences before 
the present one, the button is disabled 

 Click to go to the previous sequence. 
 Scroll through the sequences. 
 Click to go to the next sequence. 
 Click to go to the next marked sequence. 
 Click to go immediately to a particular sequence (see number 22). 
 Shows the sequence number (ʻ2ʼ in the screenshot above). In the text box you can type a different number 

and click ʻGoʼ or press return to go immediately to that sequence. 
 The number of checked events of the sequence (see number 11). 
 Click this button to set the window in the codes and event variables mode. No event texts are shown. In stead 

all event variables are shown in a spread sheet like manner. Here you can manually change the values of 
event variables. Use this mode if you want to see the values of as many event variables as possible. 

 The button for the codes mode. The codes are shown in a row, with or without one event variable. Use this 
mode if you want to see as many event codes as possible. This mode is especially useful when you want to 
study the effects of a sequence definition (see number 8). 

 The text mode. The most common mode if your file has sequence texts. 
 The event variables popup menu let you choose which event variable is visible in the codes mode (see 25) 

and the text mode (see 26). 
 The link new AV file button. Use this button to link a new audio or video file to the sequence. The locations of 

linked AV files are stored within your data file. 
 Use this button to assign the linked files of the present sequence or to a whole set of sequences. 
 If you click the remove link button, the link with the selected linked AV file is removed. 
 The select AV file popup menu let you select which one of the linked files is shown. If you move a file to a 

different location, you get a message, enabling you to link the new location.  
 Check to show existing word links and to enable you to add new ones (see number 33). 
 Click this button to add a new word link. Just drag the mouse from one word to another. 
 Shows the number of word links in the sequence 
 Use this popup menu to show either text keys or time keys. 
 Select the keyword that should be shown. The words belonging to a keyword are coloured in the sequence 

text (see number 14). 
 The number of times the selected key occurs in the sequence. 
 Click the triangle to show a drawer with the sequence variables (see section 3.2). 
 Click the triangle to show a drawer where you can enter additional information about sequences (see section 

3.3). 
 
 
2.2. The sequence variables drawer 
 

 The sequence variables field. Sequence variables concern 
characteristics of the whole sequence. Two sequence variables 
are always available, SEQSIZE and STARTTIME. 

  SEQSIZE is the number of event codes in a sequence. 
SEQSIZE concerns the number of event codes in the code field, 
not the number of paragraphs of the event texts. The value of 
SEQSIZE cannot be changed; it is changed automatically, if the 
number of codes changes. 

  STARTTIME refers to the time point of the linked AV file that 
corresponds with the beginning of the sequence. So in the screen 
shot on page 6, the STARTTIME is the moment the interviewer 
starts saying “How satisfied are you...” If each sequence has a 
different sound file, it will usually have the value 0. If the same 
sound or video file concerns a number of different sequences, 
this will not be the case. For example, if the linked file is a 
recorded interview with a large number of so-called question-
answer sequences, each representing a different sequence, the 
STARTTIME of the second sequence, is the moment the second 
question is posed.  
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 The values of the sequence variables. To manually change a value, just click on a value to edit it. To quickly 
assign a particular value to a large number of sequences, click at the name of a sequence variable. 

 If you move the mouse over the name of a sequence variable, this field shows its variable label. If you move 
the mouse over the value of a sequence variable, the value label (if available) is shown. 

 Click this button to immediately go to the window where you can change the properties of sequence variables, 
like variable and value labels (as an alternative to selecting Define variables... from the Sequence variables 
menu). 

 Check ʻShow labelsʼ to display value labels in stead of values. If no label is available for a value, the value is 
shown. 

 
 
2.3. The information drawer 
 
You can click the triangle in the lower left corner to show a drawer where you can enter additional information about 
a sequence. 
 

 
 

 Each sequence is provided with five different information fields, where you can enter any information you wish. 
You can select a particular field with one of the tabs ʻinfo 1ʼ to ʻinfo 5ʼ. The selected field remains visible if you 
move to another sequence. You can change the tab titles ʻinfo 1ʼ et cetera to more convenient names with File 
settings... from the File menu (ʻCustomizeʼ tab). 

 The contents of an information field, ʻinfo 1ʼ in this case. Here it is used to store the original question and 
response alternatives, as they appear in the questionnaire. You can type any text here. 

 
 
2.4. The tool bar 
 
The toolbar can be found in the upper left corner of the screen. 
 

 
 

 The record button. If you press this button, your actions (analyses, data manipulations, going to a different 
sequence, etcetera) are automatically recorded. You can save these recordings in a script and run the script 
at a later time, to repeat exactly the same actions on, for example, a different SEQUENCE VIEWER file. 

 Press this button to stop recording. 
 If auto recording is active, the (red) light is on. 
 Exclude particular commands from being auto-recorded 
 With this popup menu, you can select a recorded script to execute it. 
 Click to add a saved script to the popup menu (number 5), or to delete a script from this popup menu. 
 Click the ʻRunʼ button to execute the selected script.  
 Click one of these symbols to insert special characters into the text. 
 Select another symbol to insert into the text. 
 Use this popup menu to apply a text style to the selected text. 
 Use this popup menu to assign a text key to the selected text. 
 With the slider you can indent or outdent the sequence text. 
 Check to apply the indent/outdent to all sequences. 
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 Increase or decrease the line spacing between event texts (paragraphs in the sequence text). 
 Apply the line spacing to all sequences. 
 The help field. If you move the mouse over a buttons or a field, a short description of its function appears here 

(unless the meaning is self-evident). The field is only partially shown in the screen shot above. 
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3. Menu items 
 
3.1. The Sequence Viewer menu 
About Sequence Viewer 
Shows the version and copyright statements. 
Preferences 
General settings for the SEQUENCE VIEWER program. These are stored in the ‘Sequence Viewer 5 Preferences’ 
file, in your ‘Preferences’ folder (which is in the ‘Library’ folder of your home directory) on your hard drive (the 
Sequence Viewer 5 Preferences are used both for Sequence Viewer 5 and Sequence Viewer 6). 
 
3.2. The File menu 
New 
Creates a new empty SV file (Sequence Viewer file). 
Open 
Opens an existing SV file. 
Open recent 
Provides you with a list of recently opened SV files. You can select one to open it. 
Save 
Saves an SV file. 
Save as 
Saves a file with a different name. 
Duplicate file 
Makes a number of copies of a file (or of each file in a folder) and names these copies according to a list of 
names. 
Revert 
Reverts to the SV file as last saved on disk. 
Close 
Closes an SV file. If you made changes to your file, you are informed about the kind of changes, in order to help 
you decide whether or not to save the file, or close it without changing. 
Import 
You can create a new SV file from any text file that resembles event codes. Nearly any text file can be converted 
into sequences of codes. You can also create a new SV file with event variables from a text file with numbers. 
Event codes may be added to these numbers. 
Moreover you can add sequences from other SV files to the present file, sequence variables from data files 
created by statistical programs like SPSS, and texts that serve as sequence text. 
Export 
You can export a variety of combinations of sequence variables, event variables, event texts, event codes and 
keys. Sequence and event variables without additional event codes or event texts are exported as tab delimited 
files, for analyses by statistical programs. 
Compare files 
Compare files lets you compare two different SV files, in order to find differences between them. 
Page setup 
The common Macintosh dialog window. 
Print output 
Let’s you print the contents of the output window. 
Show output/Hide output 
Lets you show or hide the output window. 
File settings 
Specific settings for a particular SV file. These are stored with the file itself. 
 
3.3. The Edit menu 
Undo  
Applies to manual changes made in the text; see Undo[action] for undoing changes in the SV file caused by a 
general command. 
Undo [action] 
This command can be used to undo the last general command to change data in a number of sequences at 
once. The text between brackets shows which command is concerned. For example, if the last command was 
"Delete event variable", it will read "Undo delete event variable". You can undo up to ten successive actions. 
Cut 
The common Macintosh "Cut" command. 
Copy 
The common Macintosh "Copy" command. 
Paste 
The common Macintosh "Paste" command. The text that is pasted is sometimes adjusted a bit. For example, if 
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you copied “123 45” (with a space between 3 and 4) and paste it into a field where only numbers are allowed, 
“12345” is pasted (without the space). 
Clear sequences 
Empties particular parts of sequences, i.e. the codes, the event texts, or one or more information fields. 
Paste sequences 
Pastes codes, event variables, the event texts or the text from the information fields of a particular sequence in 
the corresponding fields of other sequences. 
Edit sequence 
Shows a dialog box that enables you to edit codes and values of event variables. The window also appears if you 
shift-click on a code in the code field of the main sequence window. 
Assign empty codes 
A quick way to insert dashes (a special code, meaning ‘not coded yet’) in the code field, in case you have non-
coded source texts. A series of dashes (one dash for each code variable, like ‘----‘ in case of four code 
variables) is called an ‘empty event code’. The number of empty event codes that is inserted for a sequence 
equals the number of paragraphs of the sequence text. 

Waveform 
Creates a waveform from the linked AV file. The AV file should be of type AIF. 
You have options to enter event codes using the waveform, and to calculate speech characteristics like pitch. 
Speech characteristics can be assigned to event variables. 

Command editor 
Creates scripts from setup windows and other commands. Scripts can be executed later again. 
Toolbar 
Lets you show or hide the different parts of the toolbar. 
 
3.4. The Sequences menu 
Define sequence 
Allows you to define a sequence, for example by neglecting ('masking') particular code variables; or by only 
taking particular subsets of a sequence into account (for example from event number 3 to the one but last event); 
or by deleting particular event codes, et cetera. The effect of a sequence definition on a sequence can be made 
visible with the Show sequence definition button (see explanation with number 8 in section 2.1). Analyses can be 
performed on such converted sequences. 
Add sequences 
Add a number of sequences at once. 

Delete sequences 
Deletes a number of sequences, for example the marked sequences. 
Sort sequences 
Sorts sequences according to the values of a sequence variable. 

Split sequences 
Splits sequences before or after a particular code, or between two particular codes. 
Add events 
Adds an event at a particular position in the sequence. The event obtains the codes for ‘not coded yet (a dash). 
Delete events 
Deletes events with a particular event code; or an event with a particular event code occurring before or after 
another event with a particular event code; or the first or the last event in a sequence. 
Combine events 
Combines two more events with exactly the same event codes. 
Lock sequences 
Options to lock or unlock sequences. If a sequence is locked, it cannot be changed. For example, a command to 
replace a particular event code by another event  code, will not affect locked sequences. 
Mark sequences 
Options to mark or unmark sequences. 
Mark random 
Marks a random selection of sequences. 

Mark links 
Marks sequences with particular link characteristics, i.e. unlinked or bad linked codes and texts, or sequences 
without linked audio/video files. 
Copy marks 
Lets you assign marks according to the values on a sequence variable and/or the marks according to a different 
mark set. 
Check events 
Options to check or uncheck events. 
Check random 
Checks a random selection of events. 



 9 

Select 
Define a subset of sequences, based on a particular mark set, and on the values on one or two sequence 
variables. 
Link code and text 
Links the event texts to the event codes. If linked, each paragraph of the event text is viewed as a separate event, 
with a linked event code and linked event variables (if available). 
Check data 
Checks the integrity of your data file, in case you have reason to expect that data became corrupted, and tries to 
correct the errors. Also checks the codes with respect to the allowed codes and the dependencies between 
codes (if defined), the values of sequence and event variables according to their minimum and maximum, 
inconsistencies with respect to text and time keys, and much more. 
 
3.5. The Text menu 
Find text 
Finds a particular text in the event text field or one of the info fields. The found text can be replaced, you can mark 
or unmark sequences with the text you're looking after, or you can check or uncheck events with a particular event 
text. Find text has many options, including finding texts that resembles a particular text (e.g. ‘resembles’ will also 
find ‘resmbles’). Or you can find only underlined text; or any number; and so on. 
Show event texts 
Shows all event texts belonging (linked) to a particular event code, or containing a particular text key. 
Word frequencies 
Shows a frequency table of all words occurring in the sequence texts. 
Text count 
Counts the number of words or the number of characters in the event text and assigns this number to an event 
variable. 
Text analysis 
Counts the number of occurrences of particular strings in the event text and assigns this number to an event 
variable. 
Speech rate 
Assigns the number of words per second to an event variable. The number of words is inferred from the event 
text of an event. The duration of that event is inferred from its onset and offset time. 
Repeated strings 
Determines if particular strings (that may part of words) are repeated within the event text. 
Auto assign keys 
Assigns a keyword to that part of the event text that is equal to, or resembles a specified text. 
Auto code 
Codes events with a linked event text that is equal to, or resembles a specified text. 
 
3.6. The Keys menu 
Define keys 
Change names or colours of text keys and time keys. 
Text keys 
Assigns a text key to a particular piece of source text. 
Time keys 
Assigns a time key to a particular part of an AV file. 
Find keys 
Finds the text, or part of an audio or video file, that is labelled with a particular keyword. You can (un)mark or 
(un)check events where the key is found. 
Delete keys 
Deletes all keys with a particular keyword from the file. 
Split event text 
Splits the event texts into smaller parts (each becoming a new event text), by inserting carriage returns at the 
start or end of text keys. 

Convert keys 
Allows you to assign keyword attributes to sequence, event, or code variables. 
Keyword length 
Shows a frequency distribution of the length of a text key (the number of words) or a time key (the duration). The 
frequency distribution can be broken down by the values of a particular sequence variable. 
Keywords table 
Calculates a frequency table of the different time or text keys (the number of times a particular keyword occurs). 
Coincidence of keys 
Creates a matrix, showing the joint occurrence of different keywords (the overlap between different keys). 
Coincidence graph 
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Creates a graph, showing the joint occurrence of different keywords. 
 
3.7. The Codes menu 
Define event codes 
Defines properties of code variables, like the allowed codes of a code variable, variable and code labels and 
inherent dependencies between successive codes. 
Show info 
Gives the defined properties, as well as a number of descriptive statistics of code variables. 
Add code variable 
Adds a code variable to the file. 
Delete code variable 
Deletes a code variable from the file. 
View event codes 
Gives a graphical representation of the event codes of a particular sequence, based on onset and offset times.. 
Find event codes 
Find sequences with a particular event code. Also allows you to replace the found event code by another event 
code, to (un)check events with a particular event code or to (un)mark sequences having a particular event code. 
Count event codes 
Counts the number of occurrences of a particular event code in a sequence, and assigns this number to a 
sequence variable. 
Copy code variable 
Copies the codes of a particular code variable to another code variable. 

Convert codes to event variable 
Assigns values to an event variable, given particular codes for the event. 
Convert codes to keys 
Assigns a keyword to the linked event text, given a particular event code. 

Frequencies 
Calculates a frequency table of event codes. 

Frequency graph 
Calculates a graph of joint frequencies of different codes of the same event code. 

Next event 
Calculates observed and expected frequencies of event codes, given a particular preceding event code. 

Previous event 
Calculates observed and expected frequencies of preceding event codes, given a particular event code. 

Matrix 
Calculates transition matrices of event codes. 

Transition graph 
Creates a graph from the transition frequencies between events. 

Tree 
Shows the transition frequencies of event codes, starting with a particular event code. 

Path 
Shows the transition frequencies of event codes between two particular event codes. 

Patterns 
Finds particular patterns of successive event codes. 

Count sequences 
Calculates a frequency distribution of sequences. 

Define agreement 
Defines a particular measure of agreement between two coded sequences. Also shows the alignment between 
two sequences, based on optimal matching. 
Assign agreement 
Assigns the agreement between a defined sequence of codes and the coded sequences to a sequence 
variable. 

Agreement matrix 
Calculates a matrix of agreements between sequences. 
Cluster sequences 
Performs a cluster analysis on coded sequences, based on the agreement between sequences 
 
Reliability 
Compares the event codes of two comparable files and calculates Cohen's Kappa as a measure of observer 
agreement. 
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Compare sequences 
Compares the event codes of two comparable files and calculates one of the agreement measures as a 
measure of observer agreement. 
 
3.8. The Event variables menu 
Define variables 
Defines a number of properties of event variables, like minimum and maximum values, variable and value labels 
and the precision of a variable. 

Show info 
Gives the defined properties and a number of statistics of event variables. 
Add event variable 
Adds an event variable to the file. 

Delete event variable 
Deletes an event variable from the file. 
Rearrange 
Rearranges the order of event variables. 

Add event time 
Adds two event variables to the file, the Onset time and the Offset time of an event. The names Onset time and 
Offset time cannot be changed. 
Delete event time 
Deletes both Onset time and Offset time from the file. 
Find value of event variable 
Finds a particular value on an event variable. Also allows you to replace values on event variables by another 
value, to (un)check the found events, or to (un)mark sequences where the value of the event variable is found. 
Compute event variable 
Computes the values of an event variable from sequence and event variables. 

Transform 
Computes the values of an event variable, according to some transformation, e.g. the square root, the natural 
logarithm, et cetera. 
Convert to code variable 
Assigns codes to a code variable, given particular values on an event variable. 
Assign event number 
Assigns the number of the sequence as appears in the file to an event variable. 
Frequencies 
Calculates a frequency table of an event variable. 
Means 
Calculates the mean of an event variable for particular event codes. 
Anova 
Performs an analysis of variance with sequences nested under the independent variable. 
 
3.9. The Sequence variables menu 
Define variables 
Defines a number of properties of sequence variables, like minimum and maximum values, variable and value 
labels and the precision of a variable. 
Show info 
Gives the defined properties, as well as a number of descriptive statistics of sequence variables. 
Add variable 
Adds a sequence variable to the file. 
Delete variable 
Deletes a sequence variable from the file. 
Rearrange 
Rearranges the order of sequence variables. 
Find value 
Find sequences with a particular value on one or two sequence variables. Also replaces values or marks 
sequences, given a particular value. 

Compute value of sequence variable 
Computes the values of a sequence variable from sequence and event variables. 
Transform 
Computes the values of a sequence variable, according to some transformation, e.g. the square root, the natural 
logarithm, et cetera. 
Assign sequence number 
Assigns the number of the sequence as appears in the file to a sequence variable. 
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Assign number of checks 
Assigns the number of checked events of a sequence to a sequence variable. 
Frequencies 
Calculates a frequency distribution of a sequence variable. 
Crosstable 
Calculates a cross table between two sequence variables 

T-test 
Performs a T-test on sequence variables. 
Oneway 
Performs a one-way analysis on sequence variables. 
Anova 
Performs an two-way of variance on sequence variables, or an analysis of variance with one factor nested under 
the other. 
Correlation 
Calculates a correlation matrix of sequence variables. 
Multiple regression 
Performs a multiple regression analysis on sequence variables. 
 
3.10. The Help menu 
Help 
Opens the help file. The whole help file can be printed to give you a printed manual (including a table of contents) 
Convert date and time utility 
Tool to convert date and time into number and vice versa. 
Support 
You can report bugs or requests for new features here. You can also check if there is a newer version of  
SEQUENCE VIEWER. 
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4. Common window buttons 
 
Most windows for analyses or data manipulations (setup windows), consist of two clearly distinguishable parts, 
separated by a blue line. The upper part provides you with a number of options that are specific for that setup 
window. The lower part, below the blue line, usually contains a Cancel button and an OK button (although the 
name of the latter usually reflects the kind of operation). To the left of these buttons a number of other buttons 
appear that have a more general meaning than the controls in the upper part. They will be described here in 
some more detail. 
 

 Help button 

This button is always located in the lower left corner. If you click on it, it brings you to the page of the help file 
where you can find more information about the setup window. 

In many cases the OK button remains disabled, until the setup for the analysis or data manipulation makes 
sense. For example, to delete a sequence variable, you should specify the name of that variable. If the name is 
incorrect, the OK button remains disabled. In some cases, with a complex setup, it may be fat from obvious why 
the OK button remains disabled (what is wrong with the setup). Just move the mouse over the help button. The 
help field of the toolbar (see number 19 of section 2.4) tells you what’s wrong with the setup. 
 

 Previous setup button 

In the upper part of the window, you can usually set a number of options to perform a particular analysis. If, at a 
later moment you open the window again, all options are set to their default values. You can click the previous 
setup button to restore the previous setup at once. This is also a handy feature if you only want to make slight 
changes to the previous setup, e.g. only change the name of an event variable. 
 

 Apply sequence definition button 
 
You can define up to nine different sequence definitions. One sequence definition is the default definition (or 
there is no default definition at all). You can use this button to activate the default sequence definition for the 
present analysis. If you click the button, the dark blue arrows turn red to tell you that a sequence definition is 
active. Moreover the name of the sequence definition appears just above the series of buttons. If no default 
sequence definition is set, the arrows remain blue and the text above the buttons states "no sequence 
definition". No sequence definition means that the event codes of a sequence just remain as they are; no 
transformations are applied. 

With this button you have also access to the Sequence definition setup window: click the button with the option 
key down. The sequence definition window is shown, where you can select or change a sequence definition 
(see Sequences: Define sequence in the Sequence Viewer help file for more information). If you're done with the 
sequence definition, click the Apply or Done button in the sequence definition window. 
 

 Define agreement button 
 
With this button you can change the agreement definition. There is always an agreement definition active; which 
one is shown at the right of the series of buttons. To change the agreement definition, just click the button. A 
sheet comes up where you can change the sequence definition (see Codes: Define agreement in the Sequence 
Viewer help file for more information). 
 

 Select sequences button 
 
You can define more complex selections of sequences on which you want to perform analyses or operations; for 
example sequences having particular values on one or two sequence variables and are unmarked. To apply 
such a selection, click the Select sequences button (the blue arrows will turn red). The number of selected 
sequences is shown above the series of buttons. Click the button once again to get rid of the selection. Option-
click the Select sequences button to get access to the Select sequences setup window. 
 

 Select marked sequences button 
 
Click at this button if you want to restrict the analysis or data manipulation to the marked sequences. The 
number of sequences that are selected in this way is shown above the series of buttons, whereas the button 
becomes check marked. Click it once again to get rid of the selection. You cannot use both the Select sequences 
button (see above) and the Select marked sequences button. 

You can select a different mark set with the mark set popup menu in the upper right corner of the main 
sequence window. You may note that a change in mark set is immediately reflected in all open setup windows, if 
applicable. Also, if you for example manually mark or unmark a sequence in the main sequence window, the text 
stating how many marked sequences are selected for the analysis, is immediately adjusted in the setup 
window. 

 

 Select checked events button 
 
Click at this button if you want to restrict the analysis or data manipulation to the checked events. The number of 



 14 

events that are selected in this way is shown above the series of buttons, whereas the button obtains a small 
check mark. Click it once again to get rid of the selection. 

Setup windows that have an Apply sequence definition button, don’t have a Select checked events button; you 
can restrict the analysis to the checked events using the sequence definition. 
 

 Table options button 
 
With the table options button, you can change some table options. If you click the button, the Preferences window 
comes up with the analyses tab activated. Here you can change the relevant options for the analysis at hand. See 
Preferences: Analyses in the Sequence Viewer help file for more information. 
 

 Save button 
 
Saves a graph or picture created by SEQUENCE VIEWER to your hard disk. 
 

 Copy button 
 
Copies a graph or picture created by SEQUENCE VIEWER to the clipboard. You can next paste it into a word 
processor document. 
 

 Output button 
 
Sends a graph or picture created by SEQUENCE VIEWER to the output. 
 

 Keep window open button 
 
Usually, after you click OK (or similar button) in a setup window to perform an analysis or other operation on your 
data file, the window closes. In some cases you may want to repeat the same action a number of times in 
succession (for example, add a number of sequence variables to your file). In that case, check the Keep open 
check box, to keep the window open after you clicked OK. 
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5. Glossary 
AV file 
Audio or video file, linked to one or more sequences. 

Bad link 
Means that the event texts and event codes of a sequence cannot be linked, because their number is different, 
for example more paragraphs in the sequence text than event codes. 

Check 
Events can be checked to distinguish them from other (unchecked) events. 

Check field 
Field in front of the code field of the main sequence window, where you can (un)check events. 

Code 
A value on a code variable. 

Code field 
Field with event codes in the main sequence window. 

Code variable 
Alphanumerical variable describing a particular aspect of an event  by using a code of one character. An event 
can have up to nine different code variables. Code variables are used to describe the meaning of an event. 

Event 
Element of a sequence, consisting of at least an event code. To the event code, an event text and event variables 
may be added. 

Event code 
The succession of codes on the code variables. The event code consists of 1 to nine codes, depending on the 
number of code variables. 

Event text 
Paragraph of the sequence text, linked to the corresponding event code. 

Event time 
Onset time and offset time of an event. 

Event variable 
Numerical variable describing properties of an event. 

Information field 
Each sequence has five information fields attached, that can be used to enter textual information about the 
sequence. 

Key 
Piece of sequence text (text key), or part of an audio or video file (time key), that is assigned a particular keyword. 

Keyword 
A particular type of key. 
 

Layout mode 
The main sequence window has three different modes: the codes and event variables mode, the codes only 
mode, and the codes and text mode. The mode is changed by clicking at one of the layout buttons. 

Link 
- The event codes and event texts of a sequence are linked if each event text belongs to one and only one event 

code. 
- A sequence can be linked to an audio file or a video file. 
- Two words of the sequence text can be linked. 

Locked 
A sequence can be locked to prevent that the data of that sequences are changed. 

Mark 
Sequences can be marked to distinguish them from other (unmarked) sequences. 

Mark set 
Sequences can be marked using one of eight independent mark sets. 

Offset time 
One of both event time variables, indicating the end of an event 

Onset time 
One of both event time variables, indicating the start of an event 
 

SEQSIZE 
Sequence variable indicating the number of events (event codes) of the sequence. 

Sequence 
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Ordered (in time or space) series of events. 

Sequence definition 
Temporary changes to the sequence of event codes. 

Sequence text 
The text in the text field of the main sequence window. Carriage returns separate the sequence text into a 
number of event texts that are linked to event codes. 

Sequence variable 
Numerical variable describing properties of the whole sequence. 

STARTTIME 
Sequence variable indicating the start time of the sequence 

Text field 
Field in the main sequence window with the sequence text. 

Variable name 
Name of code, event or sequence variable. Variable names can be 12 characters long, may contain spaces (but 
not start or end with a space), and may not consist of digits only. 

Word link 
Arrow between two words in the sequence text, indicating that these words are connected.  
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